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CHAPTER 1

INTRODUCTION

1.1 What is TINA and TINA Design Suite?

TINA Design Suite is a powerful yet affordable software package for
analyzing, designing and real time testing of analog, digital, VHDL,
and mixed electronic circuits and their layouts. You can also analyze RF,
communication,  and optoelectronic  circuits, and  test  and debug
microprocessor & microcontroller applications. Every year, electronic
circuits become faster and more complex, and therefore require more
and more computational power to analyze their operation. To meet
this requirement DesignSoft engineers have included the ability to  utilize
the increasingly popular scalable multi-thread CPUs. Computers that
incorporate dual or quad core CPUs can deliver up to 20 times faster
execution time for TINA’s analysis engine–while maintaining the
accuracy of prior single-threading computers.

A unique feature of TINA permits you to bring your circuit to life with
the optional USB controlled TINALab II  and LogiXplorer hardware,
turning your computer into a powerful, multifunction T&M
instrument. Electrical engineers will find TINA an easy to use, high
performance tool, while educators will welcome its unique features for
the training environment.

TINA is distributed in two major versions – TINA and TINA Design
Suite. TINA includes circuit simulation only, while TINA Design
Suite also includes the advanced PCB designer. This fully integrated
layout module has all the features you need for advanced PCB design,
including  Multilayer flexible PCB’s  with  split  power  planes, powerful
autoplacement  &  autorouting,  rip-up  and  reroute,  manual  and
”follow-me” trace placement, DRC, forward and back annotation, pin
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and gate swapping, keep-in and keep-out areas, thermal relief, fanout,
plane layers, Gerber file output and much more.

TINA can also be used in the training environment. It includes unique
tools for testing students’ knowledge, monitoring progress and
introducing troubleshooting techniques. With optional hardware it
can be used to test real circuits for comparison with the results
obtained from simulation. Of great importance to educators, the
package includes all the tools needed to prepare educational materials.

Schematic Capture. Circuit diagrams are entered using an easy to use
schematic editor. Component symbols chosen from the Component
bar are positioned, moved, rotated  and/or mirrored on the screen by
the mouse. TINA's semiconductor catalog allows the user to select
components from a user-extendible library. An advanced “rubber wire”
tool is provided allowing easy modification of the schematic diagrams.
You can open any number of  circuit files or subcircuits, cut, copy and
paste circuit segments from one circuit into another, and, of course
analyze any of the currently open circuits. TINA gives you tools to
enhance your schematic by adding graphics elements such as lines, arcs,
arrows, frames around the schematic, and title blocks. You can also
draw non-orthogonal (diagonal) components such as bridges and
3-phase networks.

Live 3D Breadboard Tool. You can take your design for a solder-less
breadboard (sometimes called a “whiteboard”) and automatically build
a life-like 3D picture of the breadboard. Now when you run TINA in
interactive mode, virtual components such as switches, LEDs, instru-
ments, etc. become “live” and will function with satisfying realism.
Students will use the Live 3D Breadboard tool to prepare and docu-
ment eye-catching lab experiments.

PCB Design. TINA includes only circuit simulation, while TINA
Design Suite includes TINA’s advanced PCB designer. This fully
integrated layout module has all the features you need for advanced
PCB design, including Multilayer PCB’s with split power planes,
powerful autoplacement & autorouting,  rip-up  and  reroute,  manual
and  ”follow-me”  trace placement,  DRC,  forward  and  back annota-
tion,  pin  and  gate swapping, keep-in and keep-out areas, thermal
relief, fanout, plane layers, 3D view from any angle, and much more.
With TINA Design Suite you can prepare a PCB in at least two ways:
using the G-Code control files to make in-house prototypes with mill-
ing machines using the G-Code control files provided by TINA; or
sending Gerber files to PCB manufacturers.
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Electrical Rules Check (ERC) will examine the circuit for
questionable connections between components and display the results
in the Electrical Rules Check window. ERC is invoked automatically, so
missing connections will be brought to your attention before analysis
begins.

Schematic Symbol Editor. In TINA, you can simplify a schematic by
turning portions of it into a subcircuit. In addition, you can create new
TINA components from any Spice subcircuit, whether created by
yourself, downloaded from the Internet, or obtained from a
manufacturer’s CD. TINA automatically represents these subcircuits as
a rectangular block on your schematic, but you can create any shape you
like with TINA's Schematic Symbol Editor.

Library Manager. TINA has large libraries containing Spice- and
S-parameter models provided by semiconductor manufacturers such
as Analog Devices, Texas Instruments, National Semiconductor, and
others. You can add more models to these libraries or create your own
Spice- and S-parameter library using  TINA's Library Manager (LM).

Parameter Extractor. Using TINA's Parameter Extractor you can
also create component models that more closely represent actual real
world devices by converting measurement or catalog data into model
parameters.

Text and Equation Editor. TINA includes a Text and Equation
Editor for annotating schematics, calculations, includes graphic
output, and measurement results. It is an invaluable aid to teachers
preparing problems and examples.

The circuit diagrams and the calculated or measured results can be
printed or saved to files in standard Windows BMP, JPG and WMF
format. These output files can be processed by a number of well known
software packages (Microsoft Word, Corel Draw etc.). Netlists can be
exported and imported in Pspice format and also to drive popular
PCB packages such as ORCAD, TANGO, PCAD, PROTEL, REDAC
and other programs.

DC analysis calculates the DC operating point and the transfer
characteristic of analog circuits. The user can display the calculated and/
or measured nodal voltages at any node by selecting the node with the
cursor. For digital circuits, the program solves the logic state equation
and displays the results at each node step-by-step.

Transient analysis. In the transient and mixed mode of  TINA you
can calculate the circuit response to the input waveforms that can be
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selected from several options (pulse, unit step, sinusoidal, triangular
wave, square wave, general trapezoidal waveform, and user-defined
excitation) and parameterized as required. For digital circuits,
programmable clocks and digital signal generators are available.

Fourier analysis. In addition to the calculation and display of the
response, the coefficients of  the Fourier series, the harmonic
distortion for periodic signals, and the Fourier spectrum of
non-periodic signals can also be calculated.

Digital Simulation. TINA also includes a very fast and powerful
simulator for digital circuits. You can trace circuit operation step-by-
step, forward and backward, or view the complete time diagram in a
special logic analyzer window. In addition to logic gates, there are ICs
and other digital parts from TINA's large component library.

VHDL simulation. TINA now includes an integrated VHDL
simulator to verify VHDL designs both in digital and mixed-signal
analog-digital environments. It supports the IEEE 1076-1987 and
1076-1993 language standards and IEEE standards 1164 (standard
logic). Your circuits can contain editable VHDL blocks from TINA’s
library, FPGAs & CPLDs, or VHDL components created by yourself
or downloaded from the Internet. You can edit the VHDL source of
any VHDL component and see the result instantly. With the optional
external VHDL simulator, you can develop and debug your VHDL
code both externally and inside TINA. The VHDL simulator includes
Waveform Display, Project Management and Hierarchy Browser, and
64-bit time.

Microcontroller (MCU) simulation. TINA includes a wide range
of  microcontrollers (PIC, AVR, 8051, HCS, ARM) which you can test,
debug and run interactively. The built in MCU assembler allows you to
modify your assembler code and see the result promptly.

Flowchart Editor and Debugger. Writing MCU assembly code is
often a hard and tedious task. You can simplify software development
and gain more time to design the electronics hardware if, instead of
manual coding, you use TINA’s Flowchart editor and debugger to
generate and debug the MCU code. This easy-to-use tool works with
symbols and flow control lines with which you can represent the algo-
rithm you want.

AC analysis calculates, complex voltage, current, impedance, and power
can be calculated. In addition, Nyquist and Bode diagrams of the
amplitude, phase and group delay characteristics of analog circuits can
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be plotted. You can also draw the complex phasor diagram. For
non-linear networks, the operating point linearization is done
automatically.

Network analysis determines the two-port parameters of networks
(S, Z, Y, H). This is especially useful if  you work with RF circuits.
Results can be displayed in Smith, Polar, or other diagrams. The
network analysis is carried out with the help of  TINA’s network
analyzer. The RF models of the circuit elements can be defined as
SPICE subcircuits (SPICE macros) which contain parasitic
components   (inductors, capacitors) or as an S-parameter model
defined by its S (frequency) function. S functions are normally
provided by the component manufacturers (based on their
measurements) and can be downloaded from the Internet and
inserted into TINA either manually or by using TINA’s library
manager.

Noise analysis determines the noise spectrum with respect to either
the input or the output. The noise power and the signal-to-noise ratio
(SNR) can also be calculated.

Symbolic analysis produces the transfer function and the closed form
expression of the response of analog linear networks in DC, AC, and
transient modes. The exact solution, calculated through the symbolic
analysis, can also be plotted and compared to the numerically calculated
or measured results. The built-in interpreter can evaluate and plot
arbitrary functions.

Monte-Carlo and Worst-case analysis. Tolerances  can  be  assigned
to  the  circuit  elements  for  use  in Monte-Carlo and/or worst-case
analyses.  The results can be obtained statistically, and their expected
means, standard deviations and yields can also be calculated.

Design Tool This powerful tool works with the design equations of
your circuit to ensure that the specified inputs result in the specified
output response. The tool offers you a solution engine that you can
use to solve repetitively and accurately for various scenarios. The calcu-
lated component values are automatically set in place in the companion
TINA schematic and you can check the result by simulation.
This feature is also very useful for semiconductor and other electronics
component manufacturers to provide application circuits along with
the design procedure.

Optimization. TINA’S enhanced optimization tool can tweak one or
more unknown circuit parameters to achieve a predefined target
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response. The target circuit response (voltage, current, impedance, or
power) must be “monitored” by meters. For example, you can specify
several working point DC voltages or AC transfer function parameters
and have TINA determine the values of the selected components.

Post-processor. Another great new tool of  TINA is its
post-processor. With the post-processor, you can add new curves of
virtually any node and component voltage or current to existing
diagrams. In addition, you can post-process existing curves by adding
or subtracting curves, or by applying mathematical functions to them.
You can also draw trajectories; i.e., draw any voltage or current as a
function of another voltage or current.

Presentation. With TINA you can make quality documents
incorporating Bode plots, Nyquist, Phasor, Polar and Smith
diagrams, transient responses, digital waveforms and other data
using linear or logarithmic scales. Customize presentations easily using
TINA’s advanced drawing tools-you can print your plots directly from
TINA, cut and paste them into your favorite word processing
package, or export them to popular standard formats. Customization
includes complete control over texts, axes, and plot style; e.g., setting
line width and color, fonts in all sizes and color, and automatic or
manual scaling for each axis.

Interactive mode. When everything is in order, the ultimate test of
your circuit is to try it in a “real life” situation using its interactive
controls (such as keypads and switches) and watching its displays or
other  indicators.  You  can  carry  out  such  a  test  using  TINA’s
interactive mode. You can not only play with the controls, but you can
also change component values while the analysis is in progress. In
addition, you can assign hotkeys to component values and switches to
change them simply by pressing a key. You will immediately see the
effect  of   the  change.  You  can  also  test  MCU  applications  in  TINA’s
interactive mode. You can not only run and test them using the several
lifelike interactive controls e.g., keyboards. but you can also debug them
while the MCU executes  ASM code step by step,  And displays the
register contents and TINA’s outputs in each step. If  necessary you can
modify the ASM code on the fly and test your circuit again without
using any other tool.

Virtual instruments. In addition to standard analysis presentations
such as Bode and Nyquist plots, TINA can present its simulation
results on a wide range of high-tech virtual instruments. For example,
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you can simulate the time response of your circuit using a virtual square
wave  generator  and  a  virtual  oscilloscope.  Using  TINA’s  virtual
instruments is a good way to prepare for the use of real test and
measurement equipment. Of course it is important to remember that
the “measurement results” obtained with virtual instruments are still
simulated.

Real-time Test & Measurements. TINA can go beyond simulation
when supplementary hardware is installed on the host computer.
With this hardware, TINA’s powerful tools can make real-time
measurements on real circuits and display the results on its virtual
instruments.

Training and Examination. TINA has special operating modes for
training and for examination. In these modes, under TINA’s control,
the students solve problems assigned by the teacher. The solution
format depends on the types of problems: they can be selected from a
list, calculated numerically, or given in symbolic form. The interpreter -
providing a number of solution tools - can also be used for problem
solving. If  the student cannot solve the problem, he/she can turn to
the multilevel Advisor. The package includes all the tools needed to
produce educational materials. A collection of examples and problems
worked out by teachers is also part of the package. Another special
educational function of TINA is the software or hardware
simulation of  circuit faults to practice troubleshooting. Using TINA,
you can transform existing PC classrooms into contemporary
electronics training labs at low cost.

1.1.1 What is TINA-TI?

TINA-TI is a complimentary, limited version of  TINA Design Suite
circuit simulation software that is distributed by Texas Instruments
(TI) in cooperation with DesignSoft, the developer of TINA.

It includes macromodels and application examples for TI integrated
circuits now including not only analog Operational Amplifiers but also
SMPS controllers and is intended to demonstrate commercial circuit
applications for TI’s products.

TINA-TI is not authorized for educational use, and should not be
used by educators for the purpose of educating pupils, or by students
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or others for educational purposes. For educa-tional use special ver-
sions of TINA are available which were developed by DesignSoft es-
pecially for teachers and students. For more information see
www.tina.com under “Education”.

The information provided and derived herein is believed to be reliable;
however Texas Instruments Inc. (TI) assumes no responsibility for
inaccuracies or omissions. TI assumes no responsibility for the use of
this information, and the use of all such information shall be entirely
at the user’s own risk. No patent rights or licenses of  any kind are
implied or granted to any third party. TI does not authorize or warrant
any TI product for use in life-support devices and/or systems.

TINA-TI is derived from TINA Design Suite, the Complete Electron-
ics Lab program by DesignSoft for analyzing, designing and real time
testing of analog, digital, VHDL, and mixed electronic circuits and
their PCB layouts.

From TINA-TI you can upgrade to the full version of TINA Design
Suite at a special price at

www.tina.com/ti-upgrade.htm

1.1.2 New features in TINA-TI v9

- Multi core support

- Over 100 SMPS models from TI

- Up to 10 times faster on 1 core, 15x on dual core, 20x on quad core

- Fast diagram drawing and processing speed, even for very large cir-
cuits, scrollbar for moving multiple diagrams on the same page

- Combinational and parallel stepping, separate cases in diagram

- Schematic Symbol Editor Included

- Addition of new components from other manufacturers

- The nodes list in post processor shows the names and node names in
the relevant macros

- Gain margin, Phase margin

- Linear circuits allowed

- Ideal Opamp added
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- Minimizing TINA while analysis is running

- Running several TINAs on the same computer simultaneously

- Running second TINA without extra license allowed on the same
computer

- Position cursor both by entering x or y value,  0 db Cross over
frequency

- ERC in Spice subcircuts, you can make and ERC either for the whole
circuit or for  (Spice or schematic) subcircuts

- ERC detects floating nodes in spice subcircuits

- Open Examples command in File menu

- Open .cir files from Open command in the File menu

- My Places button in Open dialog

- Conversion to v7, for compatibility with v7 and v8

- Possibility to place hyperlink on the schematic diagram

- Detailed run-time statistics

- Links to TI Design Center, FAQ and  Sample part request

-XML format export and import of circuit schematic diagrams

- TINA is now digitally signed by DesignSoft

1.1.3 Extra features in TINA DESIGN SUITE 9
compared to TINA-TI

- Digital and mixed-mode analysis

- Monte Carlo and Worst-case analysis, statistics

- Symbolic analysis

- Interactive circuit analysis, with switches, buttons, displays, etc.

- Multiparameter optimization

- Network analysis, S-parameters

- Large extendible component library containing more than 20,000
parts and models

- User defined excitation

- Parameter stepping with multiple parameters
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- Analog control components and simulation

- Fourier spectrum (continuous spectrum)

- Phasor-,Nyquist- and group-delay diagrams

- Interpreter for post processing the results

- Optional real-time test and measurement

- Library manager for extending component libraries

- Parameter extractor for creating new component models

- More components: Optoelectronics, bus, VCO, BSIM, communica-
tion circuits

- Built-in VHDL analysis also in interactive mode

- User defined VHDL components, modifiable on-the-fly VHDL,
Xilinx - - UCF generation of digital circuits for synthesis, place-and-
route and presentations with the TINA FPGA board

- Microcontroller simulation including PIC, AVR, 8051 and ARM 9
processors

- ASM debugging

- Stress (smoke) Analysis

- Active and passive filter design

- Logic design (Truth table, Karnaugh table, Quine-McClusky optimi-
zation, schematic diagram generation)

- Single click 3D component preview

TINA Design Suite v9:

- Includes all TINA 9 features plus TINA’s advanced PCB designer
Autoplacement and autorouting, rip-up-and-retry
Manual and “follow-me” trace placement
Forward and backward annotation
Pin and gate swapping
Keep-in and keep-out areas
Thermal relief, fanout
Plane layers for multilayer designs
Gerber file output
Footprint Editor

Much more, described at
www.tina.com/ti-upgrade.htm
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CHAPTER 2

NEW FEATURES IN

TINA
This chapter describes the new features and changes in the latest TINA
v9 version and also in the previous 8.0 and 7.0 of TINA. Many of
them were suggested by TINA users, while others were created by
DesignSoft’s team of  software and electrical engineers. We are sure you
will share our excitement about these new features. Note that not all
new features of TINA 9 are included in TINA-TI.

2.1 New features in TINA-TI v9
• Multi core support

• Over 100 SMPS models from TI

• Up to 10 times faster on 1 core, 15x on dual core, 20x on quad core

• Fast diagram drawing and processing speed, even for very large circuits,
scrollbar for moving multiple diagrams on the same page

• Combinational and parallel stepping, separate cases in diagram

• Schematic Symbol Editor Included

• Addition of new components from other manufacturers

• The nodes list in post processor shows the names and node names in
the relevant macros

• Gain margin, Phase margin

• Linear circuits allowed

• Ideal Opamp added

• Minimizing TINA while analysis is running

• Running several TINAs on the same computer simultaneously

• Running second TINA without extra license allowed on the same
computer
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• Position cursor both by entering x or y value,  0 db Cross over fre-
quency

 • ERC in Spice subcircuts, you can make and ERC either for the whole
circuit or for (Spice or schematic) subcircuts

• ERC detects floating nodes in spice subcircuits

• Open Examples command in File menu

• Open .cir files from Open command in the File menu

• My Places button in Open dialog

• Conversion to v7, for compatibility with v7 and v8

• Possibility to place hyperlink on the schematic diagram

• Detailed run-time statistics

• Links to TI Design Center, FAQ and  Sample part request

• XML format export and import of circuit schematic diagrams

• TINA is now digitally signed by DesignSoft

2.2 List of New features in TINA v9
• Full Vista and Windows 7 compatibility

• Multi core support for dual, quad, i7 and higher multi-core processors

• Enhanced analysis speed up to 10 times higher speed on 1 core, 15x on
dual core, 20x on quad core

• Improved convergence performance based on the latest state of the art
algorithms

• Advanced powerful Spice-VHDL mixed mode analysis

• Extended catalog with ARM 7, ARM 9 and  HCS08 microcontrollers,
more SMPS  ICs models,  realistic ADC and DAC models, LCD
display, Bi-color LEDs

• Extended MCU simulation, USB  and other modules

• Programmable Design Tool where users can implement design
procedures  for calculating and setting circuit parameters  so that the
circuits can produce predefined target output values.

• Extended flowchart tool: PIC, AVR, 8051, code box, USART,  external
interrupt handling

• Open and save TINA designs, models and libraries directly  from the
Web
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• Import  Spice .CIR and  .LIB files directly from the Web

• Import Libraries, Examples and Designs from any earlier versions of
TINA v7 and later.

• Show analysis results on diagrams during analysis

• Fast diagram drawing and processing speed, even for very large circuits

• New tool in the View menu of the diagrams for easier hiding and
showing curves on diagrams

• New more effective storing of analysis results, save all analysis results
for all circuits without speed compromise

• Parametrizable output curve filter for even more effective storage of
results

• Scrollbars for browsing multiple diagrams on the same page

• New diagram cursor tools to find and annotate

local and global maximum, minimum

gain and phase margins

zero crossover frequency

horizontal  and vertical coordinates

• Combinational and parallel stepping , show stepping cases (test benches)
in separate diagrams

• More advanced  tools for addition of parts to TINA from semicon-
ductor manufacturers  both from downloaded files and directly from
the internet

• Node list in post processor now displays macro names and local node
names in the relevant macros

• Minimize TINA main window while analysis is running

• Run two TINA instances on the same computer

• Multi-level, hierarchical ERC. Checks  the main or any subcircuts,  or
the whole circuit in full depth

• ERC detects and shows floating nodes in Spice subcircuits

• Open Examples command in File menu, for easier return to TINA’s
Examples folder

• Open  .CIR  files from Open command in the File menu

• New arrow button in Open and Save dialog, for easier finding the
TINA EXAMPLES or User folders
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• Updated  and extended examples under the EXAMPLES folder

• Conversion of circuits to TINA v7 format, for compatibility with
TINA v7, v8 and v9

• Detailed Transient Statistics from the View menu

• TINA v9 is now digitally signed by DesignSoft

PCB Design

• G-Code export of PCB designs for creating control files for milling
machines

• Revised and largely extended PCB footprint catalog

2.3 List of new features in TINA Design
Suite 8

• Vista style installation and folder scheme

• Behavioral building blocks, nonlinear controlled sources

• Powerful Spice-VHDL co-simulation including MCUs

• Finite State Machine (FSM) editor with VHDL generation

• Flowchart editor and debugger for controlling MCUs

• Any number of MCUs in one circuit

• Extended MCU catalog including PIC18, CAN and more

• Execution time measurement and statistics for Transient Analysis

• Hyperlinks can be added to schematics and to the diagram window

• Extended semiconductor catalog

• Application examples from Texas Instruments

• Labview based virtual instruments

• Interface to build LabVIEW based virtual instruments

• Wave (.wav) files can be used as input

• Wave (.wav) export output file

• New Open Examples command in file menu to open built in
examples

• Autosave. Save your current schematic or PCB design at adjustable
time intervals.

• Parameter adding possibility to Spice subcircuits

• On line update possibility for libraries, program or both
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• Post-processing formulas are stored with schematics, editable later

• Live 3D Breadboard (displaying and animating circuits with 3D parts
on a virtual 3D breadboard)

• 3D virtual instruments to prepare and document lab experiments

• Integrated electronic design textbook with “live” circuits (optional)

• SMPS design templates from Christophe Basso (optional)

• Detection of components or nodes linked with convergence or

irregular circuit problems.

PCB Design (Only in TINA Design Suite v8 Edition, additional to TINA v8)

• Creating “flex” PCBs including 3D display

• Creating PCBs of any shape including round edges

• Buried and blind vias

• Extended catalog

• Improved optimizing autorouter

• Display of complete 3D circuits including parts connected externally to
the PCB





Installation

TINA Quick Start 23

IN
S

TA
L

L
A

T
IO

N

CHAPTER 3

INSTALLATION AND

START-UP

3.1 Installation Procedure

3.1.1 Minimum hardware and software requirements

• Intel Pentium or equivalent processor

• 256 MB of RAM

•  200 MB of available hard disk space

• CD-ROM

• Mouse

• VGA adapter card and monitor

• Microsoft Windows 9x / ME / NT / 2000/ XP / Vista /
Windows 7

3.1.2 Installation from TI website

TINA-TI can be downloaded as a zip file from Texas Instruments
web site at www.ti.com/tina-ti. To download and start installation
click the Download button, select Open, and after the download
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3.1.3 Installation from CD-ROM

To begin the installation simply insert the CD into your CD-ROM
drive. The Setup Program will start automatically if the Auto-Run
function of your CD-ROM has been enabled (Windows-Default).

If not, Select Start/Run and type:

D:SETUP (Enter) (where D represents your CD-ROM drive).

The setup program will start.

3.1.4 Following the Installation Steps

TINA’s Setup Procedure follows the steps standard with most
Windows Programs. There are several  screen pages where you can
enter or change important installation choices, such as Type of
Installation, Destination Directory, etc. To continue installation, click
on . You can always step back, using the -Button. If  you
do not want to continue installation for any reason, click on . If
you elect to cancel installation, the program will ask you if you really
want to exit. At this point you can either resume or exit Setup.

3.1.5 Welcome and Software License Agreement

To begin the Procedure click on Next on the Welcome Page. The
first step is the Software License Agreement.

By clicking on “Yes” you are agreeing fully with DesignSoft’s Terms and
Conditions for using this software.

NOTE:

double-click on the TINA9-TI.exe file inside the zip file. You can also
download and save the zip file. Open the saved copy and doubleclick
TINA9-TI.exe inside the zip file. The setup program will start.
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3.1.6 Entering User Information

This data is used to personalize your copy of the software. By
default, the installation program picks up the data entered when you
set up Windows. You accept these names as defaults by clicking on
Next or you can change them.

3.1.7 Choose Destination Location

Here you can select an Installation Directory other than the one
suggested as a default. The default is the Windows Standard Directory
for Programs. To change the directory, click on Browse and select a
different drive and/or directory from the Choose Folder Dialog.

IMPORTANT NOTE:

If you are installing TINA for Windows to a hard disk that already has an earlier
version of TINA, you must be sure to use a new directory name for TINA for
Windows, such as the suggested directory, C:\Program Files\DesignSoft\Tina,
or the working files you have already created will be overwritten and lost. If
uncertain, exit setup, copy your TINA files safely to another hard disk
directory or to floppy disks, then resume setup.
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3.1.8 Selecting the Program Folder

Here you can choose where in the Programs Section of your Windows
Start Menu the Program Icons will appear. The default is a new sub
menu called for example TINA 9 – Industrial. You can change this
name or select an existing Program Folder from the list.

3.1.9 Selecting the Symbol Set

TINA can display its component schematic symbols according to the
US (ANSI) or the European (DIN) conventions. Select the one
appropriate for you.

3.1.10 Final check and copying the files

This page lists the settings you have made, giving you an opportunity
to check and alter them and step back if  changes are necessary. After you
click on Next, the Setup Program starts copying the files automatically.

3.1.11 Completing the Setup

After all the selected files have been copied and the Start Menu entries
created, you are asked if you want to place a Shortcut to the TINA
program file on your Desktop. The last page indicates a successful
installation and invites you to open and read a file with the latest
information about TINA. We urge you to take a moment and review
that file. Click on finish when you’re ready.
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3.2 Uninstalling TINA

You can uninstall TINA at any time. Note that this will not delete files
you have created.

1. To begin Uninstallation choose Tina from the TINA Start Menu
Entries.

2. In the window that appears, double-click on Uninstall Tina.

3. Click on Yes if  you are positive you want to uninstall TINA .

After all the files have been removed successfully, an OK Button
appears. Click on it and uninstallation is complete.

3.3 Starting Up

After successfully installing TINA, you can start the program by simply
double-clicking the TINA icon on your Desktop or by choosing Tina
from the Tina Start Menu Entries.

3.4 Experimenting with Example Circuits,
avoiding common problems

Start the program and click the File menu item in the top line of the
screen to drop down the File menu. Select the Open command and the
standard open file dialog box appears with *.TSC, indicating that a file
name with .TSC extension is sought. Select the EXAMPLES folder,
and a list of files with .TSC extensions will appear.

After selecting a file, the circuit schematic will appear. Now you can
execute an analysis, modify or expand the circuit, and evaluate the
results.
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CHAPTER 4

GETTING STARTED

In this chapter, we present TINA’s screen format and menu  structure.
A step by step introduction is given using examples.

4.1 Schematic Editing Using the Mouse

Here are some basic mouse techniques to help you edit schematics:

4.1.1 Using the right mouse button

If you press the right button of the mouse at any time, a popup menu
appears. Using this menu you can:

• Cancel Mode: Exit from the last operation (e.g. moving a compo-
nent, drawing a wire).

• Last Component: Return to the last component and reposition it.

• Wire: Switch to wire-drawing mode. In this mode, the cursor turns
into a pen and you can draw a wire. For more details, see the Wire
paragraph below.

• Delete: Delete selected component(s).

• Rotate Left, Rotate Right, Mirror: Rotate or mirror the
component currently selected or being moved. You can also rotate a
selected component by pressing the Ctrl-L or Ctrl-R keys.
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• Properties: Use this command to edit the properties (value, label)
of the component currently selected or being moved. From the Prop-
erties menu, you can set all parameters of a component (before it is
placed). This lets you place multiple copies of the component, all with
the properties just entered. While you are in the component property
editor, the right mouse button has another function. When you are
editing the field of any component parameter other than the label
field, you can copy that field to the label field by pressing the right
mouse button and then selecting the Copy to Label command. You can
accomplish the same thing by pressing [F9].TINA PRO v6 can be
extended with an optional integrated VHDL simulator that verifies
VHDL designs both in digital and mixed-signal analog-digital  envi-
ronments. The VHDL simulator includes Waveform Display, Project
Management and Hierarchy Browser, and 64-bit time. It supports the
IEEE 1076-1987 and 1076-1993 language standards and IEEE stan-
dards 1164 (standard logic), 1076.3 (numeric standard),and 1076.4
(VITALstandard).

4.1.2 Using the left mouse button

In the descriptions below, ‘clicking’ always refers to the left mouse
button.

• Selection: Clicking on an object will select the desired object and
deselect all other objects.

• Multiple selection: Clicking while holding down the [Shift] key
will add the object under the cursor to the group of currently selected
objects. If the object under the cursor is already in the cur rently selected
group, clicking will remove it from the group.

• Block selection: To select a block of  objects all at once, first make
sure there is no object under the cursor. Then press and hold down the
left button while moving the mouse (dragging). This will create a
rectangular block, and all objects within the block will be selected.

• Selection of all objects: Press Ctrl+A to select all objects.
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• Moving objects: A single object can be moved by dragging it
(Position the cursor on the object, press and hold the left button, and
move the mouse.) Multiple objects can be moved by first selecting
them (see above), then clicking the left button while the cursor is over
one of the selected objects, holding the left button down, and
dragging.

• Parameter modification: Double-clicking on an object will bring
up its parameter menu so that you can modify its parameters (if it has
any).

• Crossing wires: The crossing of two wires does not result in a
connection at the crossing unless you deliberately choose there tob e
one. Use Edit.Hide/Reconnect to place or remove a connecting dot.
However, it is better drafting practice to never make a connection at a
wire crossing, as this avoids ambiguity about the presence or absence
of a dot.

• Block or symbol copying: After a block or symbol has been
selected, you may copy it by pressing Crtl+C. Then click outside the
block or symbol to release it, and press Crtl+V. You will see a copy of
the block which you can place as you wish. If the schematic window
doesn’t show enough room for the copy, press Alt - to zoom out.
Once you’ve located the block, click the left mouse button once to
anchor it and a second time to deselect the moved block.
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4.2 Measurement Units

When setting parameters for electronic components or speci-
fying numerical values, you may use standard electronic ab-
breviations. For example, you can enter 1k (ohm) for 1000
(ohm). The multiplier abbreviations should follow the numeric
value, e.g., 2.7k, 3.0M, 1u, etc.

The following characters indicate multiplier factors:

Upper and lower cases must be carefully distinguished (e.g., M = m), and
the selected letter must follow the numeric characters without a space (e.g.,
1k or 5.1G), or TINA will indicate an error.

p = pico = 10-12 T = tera = 1012

n = nano = 10-9 G = giga = 109

u = micro= 10-6 M = mega = 106

m= milli = 10-3 k = kilo = 103

NOTE:

4.3 The Basic Screen Format

After start-up, the following screen appears on your monitor:
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The Menu bar

The Cursor or pointer: This is used to select commands and to
edit schematics. You can move the cursor only with the mouse.

Depending on the mode of operation, the cursor assumes one of the
following forms:

An arrow, when a command selection is required in the edit window.

A component symbol (accompanied by an arrow and small box),
when inserting that component onto the circuit in the schematic win-
dow. Until the position of  the component on the schematic is chosen,
its movement is controlled by the mouse.

A pen, when defining the endpoint of a wire.

An elastic line, when defining the endpoint of a wire or the second
node of an input or output.

An elastic box, when defining a block after fixing its first corner.

A dashed line box, when positioning a component label or a text
block.

A magnifying glass, when defining a zoom window.
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The Schematic window: This shows the circuit schematic cur-
rently being edited or analyzed. The schematic window is actually a
window onto a larger drawing area. You can move the screen window
over the full drawing area using the scroll bars at the right and bottom
of the screen. When selecting the New command on the File menu,
the system automatically aligns the origin of the editor window with
the center of the entire editor drawing area. The same is true when an
existing circuit file is loaded, as this is the default window position.

You can think of  TINA’s schematic as existing on several “layers.” In
addition to the primary layer that holds components, wires, and text,
there are two other drawing layers, which you can turn on or off indi-
vidually. It is generally convenient to have these two layers on.

View|Pin Markers On/Off: Displays/hides component pin ends.

A grid of closely spaced dots covering the entire drawing area may be
made visible or invisible in the schematic window, depending on the
current state of the grid button of the Grid On/Off switch on the View
menu. At some schematic zoom levels, you will not see the dots of the
grid; nevertheless, all component pins and connecting wires will be on
the grid. These dots represent the only available interconnecting points.
Component symbols are positioned on the drawing area horizontally
and vertically. These symbols are rigid patterns with predefined pin
positions and are handled as single units. This permits the software to
unambiguously recognize the network nodes.

View|Grid On/Off: Displays/hides the grid.

The Tool bar: You can select most of   the editor commands (e.g.,

select, zoom, wire etc.,)  from this tool bar. Let’s summarize the most
important commands on the Toolbar. You can find more detailed
information in TINA’s Help system. Note that most commands on
the toolbar can also be found under the drop down menus, and can
often be activated by Hotkeys. We show the menu name separated from
the command name by a dot (Menu name.Command name ).

 (File.Open)  Opens a schematic circuit file (.TSC or .SCH),

TINA macro files (.TSM) or Spice netlist files (.CIR).

.TSC extension is the current schematic file extension used in TINA
v6 and above.  The .SCH extension was also used for schematics in
TINA v4 and  v5.
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.TSM is the extension of TINA macros, which can contain
asubcircuit either as a TINA schematic, Spice netlist, or VHDL
code.

.CIR files must be circuit files or subcircuits in Spice netlist format.
The files will appear in the Netlist Editor, where you can execute
most TINA analyses, and edit or complete the netlist.

 (File.Open from the web) This command starts the built in web

browser that allows you to navigate to any website and then di-
rectly open TINA files with TSC, SCH or CIR extension by simply
clicking a link. It will also save TSM, LIB, and TLD files into their
proper place in the user area. Finally, TINA will recognize the.ZIP
file extension and will help you select, copy, and extract files.

By default  the built in web browser in TINA opens the
TINA circuits on Web page on the www.tina.com website
(at  the time of  writing this manual  www.tina.com/English/
tina/circuits  ) where you will find  interesting  electronic  circuit files
which you can download or open directly from the web and then
simulate with TINA.

 (File.Save) Saves the actual  circuit or subcircuit into its original

storage location. It is wise to frequently save the circuit that you are
working on to avoid loss of data in case of a computer crash.

 (File.Close) Closes the actual circuit or an open subcircuit on

the screen. It is very useful for closing an open subcircuit.

 (Edit.Copy) Copy a selected part of the circuit or text to the

clipboard.

 (Edit.Paste) Paste Clipboard contents into the schematic

editor. Note that the content may come from the schematic editor
itself, TINA’s diagram window, or any other Windows program.

 Selection mode. If this button is pressed you can select and drag

components with the cursor. To select a component (part), wire or
text, just click on it with the cursor. You can also select several
objects by holding down the Ctrl key and clicking on the objects
one-by-one; or by clicking at one corner of the area, holding down
the left mouse button, moving  to  the  opposite  corner  and  then
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releasing  the  mouse button. Selected objects will turn red. You can
drag the selected objects by dragging one of   them. Click and hold
the left mouse button when the cursor is over one of the selected
objects and move them with the mouse. You can unselect all
selected object(s) by clicking on an empty area. One or more
selected objects can be deleted while leaving the others still selected
by holding the Ctrl key down and left-clicking the mouse.

You can select all the wire segments, connected by the same ID on
Jumpers, by holding down the Shift Key and clicking one of the
wire segments.

 (Insert.Last component) Retrieves the last component inserted,

for a new insertion of another copy, with the same parameters as
the previous insertion.

 (Insert.Wire) Use this icon for inserting (adding) wires to the

schematic design.

 (Insert.Text) Add comments into schematics and analysis

results.

 (Edit.Hide/Reconnect) Use Hide/Reconnect to place or remove

a connecting  dot  between  crossing  wire  or  wire-component
connection.

 (Edit.Rotate Left (Ctrl L), (Edit.Rotate Right (Ctrl R),

Rotates  the  selected component.

 (Edit.Mirror) Mirrors the selected component.

Hotkeys  Ctrl L, Ctrl H

 Switches On/Off the grid. I.e.makes the grid visible or

invisible.

 Explicitly zoom in on a selected portion of  the current view. It

will also zoom out a portion if you just click with the icon into the
middle of the area you want to zoom out.
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 Select zoom ratio from a list from 10% to 200%. You can

also select Zoom All which will zoom the effective drawing to full
screen.

Interactive modes, see also on the Interactive menu:

DC mode

AC mode

Continuous transient mode

Single shot transient mode, the time is the same as set

at Analysis Transient

Digital mode

VHDL mode

 With this listbox you can select the analysis and the Interactive

Mode Options dialog.

 (Analysis.Optimization Target)  Select Optimization Target  to

set up Optimization mode or to change settings.

 (Analysis.Control Object) Select Control Object for Parameter

Stepping or Optimization.

 (Analysis.Faults enabled) If  this button is pressed it enables

component Faults, set by Fault property of components. You can
set component faults with the Property Editor by double-clicking
on components.

 (View.3D view/2D view) Hotkey F6. 2D/3D view. If  this

button  is  pressed,  TINA’s Schematic  Editor  displays circuit
components as 3D pictures of the real component assigned to the
schematic symbol. This is a simple but useful check before starting
the PCB design.

 (Tools.PCB Design) Invokes the dialog which initiates the PCB

design module of TINA, if available.
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  (Tools.Find component) Find

Component tool. Invokes a component searching and placement
tool. This tool helps you find by name any component in the
TINA catalog. The search string that you enter will be found
wherever it occurs  at  the  beginning,  at  the  end,  or  anywhere
within  the component’s name. This tool is useful when you don’t
know where a particular component is located, or if you want a list
of all the components that match particular search criteria. A
component found in a search can be placed immediately into the
schematic by selecting it and pressing the Insert button of this
tool.

 Component list. With this tool you can

select components from a list.

The Component bar: Components are arranged in groups, named
by the tabs on the Component bar. Once you have selected a group, the
available component symbols appear above the tabs. When you click
on the desired component (and release the button), the cursor changes
to that component symbol and you can move it anywhere in the draw-
ing area. You can also rotate the component by pressing the + or - keys
(on your computer’s numeric keypad) or mirror it by pressing the
asterisk (*) key (also on your computer’s numeric keypad). Once you
have selected the part’s position and orientation, press the left button
of the mouse to lock the symbol in place.

Find component tool: This tool helps you find by name any

component in the TINA catalog. The search string that  you enter will
be found wherever it occurs–at the beginning, at the end, or anywhere
within the component’s name.

This tool is useful when you don’t know where a particular compo-
nent is located, or if you want a list of all the components that match
particular search criteria. A component found in a search can be placed
immediately into the schematic by selecting it and pressing the Insert
button of this tool.

Open files tab: You can have several different circuit files or differ-
ent parts (macros) of a circuit open in the schematic editor at the same
time. Clicking on a tab brings that circuit page up in the editor.
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The TINA Task bar: TINA’s Task bar appears at the bottom of

the screen and provides speed buttons for the various tools or T&M
instruments currently in use. Each tool or instrument operates in its
own window and can be made active by clicking on its speed button
(icon of the tool). Once the cursor is over the speed button, a brief
hint appears. Note that the first button (furthest to the left), the Lock
schematic button, has a special function. When the Lock schematic
button is pressed, the schematic window is locked in place as a back-
ground behind other windows, so that it can never cover a diagram or
virtual instruments. When the schematic window is not locked and it
is currently selected, you will always see the entire schematic window
with any other windows hidden behind.

The Help line: The Help line, at the bottom of the screen,  pro-
vides short explanations of items pointed to by the cursor.
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Press the Help button on the component dialog box to invoke TINA's HTML-
based help resource. You will find the parameters and mathematical model
of the selected component. You can also access Component help from the
help menu.

NOTE:

4.4 Placing the Circuit Components

Components are selected from the Component bar and their symbols
are moved by the mouse to the required position. When you click the
left mouse button, the program locks the pins of the component
symbol to the nearest grid dots.

Components can be positioned vertically or horizontally and rotated
by 90-degree steps in a clockwise direction by pressing the [+] or [Ctrl-
R] keys, or in a counterclockwise direction with the [-] or [Ctrl-L] key.
In addition, some components (like transistors) can also be mirrored
around their vertical axis by using the [*] key on the numeric keypad.
You can also use the  buttons or the popup menu (right mouse
button) to position components.

After a component symbol has been selected and positioned, you may
double click on it to enable a dialog window where you can enter
parameter values and a label. When entering numeric values, abbrevia-
tions of integral powers from 10-12 to 1012 can be used. For example,
1k is understood as 1,000.

TINA will automatically assign a label for each component you place
on the schematic. It will also display the numerical value of the main
component parameter (for example: R4 10k). Note that the value is
shown only if  the Values option of  the View menu is checked. For
files from the older versions of  TINA, the Values option is turned off
by default. The first part of  the label, e.g., R4, is required for symbolic
analysis modes. You can also display the units of  the                capacitors
and inductors (for example: C1 3nF) if  both the Values and the Units
options of the View menu are checked.
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4.4.1 Wire

A wire establishes a simple short (zero ohm connection) between
two component pins.

To place a wire, move the cursor to the component terminal point
where you want to begin. The cursor will change into a drawing pen.
Depending on View.Options settings you can draw a wire in two
different ways:

1) Select the starting point of the wire with a left mouse click, then
move the pen with the mouse while TINA draws the wire along the
path. While drawing the wire, you can move in any direction and the
wire follows. At the end point of the wire, click the left button of the
mouse again. This drawing mode is the default setting in version 6
of TINA.

2) Hold down the left mouse button while positioning the pen; release
it at the end point.

The actual wire-drawing mode depends on the editor options set-
tings in View.Options. TINA by default uses the first method, but
the program will remember that you have changed wire-drawing
mode.

While drawing a wire, you can delete previous sections by moving
backwards on the same track. By pressing the Ctrl key while drawing
you can move the last horizontal or vertical section.

You can easily modify existing wires by selecting and drag-
ging sections or edges.

For short wire sections, you may need to hold down the shift
key while drawing.

You can also invoke the Wire-drawing tool by the Insert|Wire com-
mand (hotkey: [Space]). You can start drawing the wire at any place by
clicking the left button of the mouse. When you have completed
wiring, use the popup menu, press the right mouse button, or press
the Esc key to terminate the wiring mode.

Be sure not to leave any component nodes unconnected. If there are
unconnected components or terminals, TINA’s Electric Rule Check
tool (ERC) will issue a warning (unless you have disabled it).
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Wire segments made by the Wire tool are always vertical or horizontal.
However, you can add angled wire segments using the components
made for bridges, Y and D circuits under the Special component toolbar.

4.4.2 Input and Output

Certain types of  analysis (DC Transfer characteristic, Bode diagram,
Nyquist diagram, Group delay, Transfer function) cannot be executed
until both input and output have been selected. These establish where
the excitation is applied and where the circuit response is taken. The
output(s) chosen also determine which curve(s) will be displayed in
the chosen analysis mode. Sources and generators can be configured as
inputs, while meters can be configured as outputs. However, meters
can also serve to determine the location of  the input quantity that will
be used when computing AC Transfer curves and functions. For even
greater flexibility, inputs or outputs can be established at nearly any
location by using the Insert|Input and Insert|Output commands.
Note that you can define the input parameter for parameter sweeping
only through the Insert|Input command.

To insert an input or output, move the cursor over the icon on the
Tool bar, click, release, and drag the input or output to the schematic
node that it should define. Then click the mouse button and hold it,
while you drag the input or output in the direction of the other node,
(usually a ground reference node). When the input or output has been
extended to the second node, release the mouse button.

Since an input reference can be established in so many ways, it is impor-
tant to remember that only one input at a time can be defined within a
circuit.

Similarly, in some of  TINA’s analysis methods (e.g., Symbolic Analy-
sis) only one output can be defined within a circuit.
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4.5 Exercises

These exercises will help you build upon and integrate what you’ve
learned from the manual so far.

4.5.1 Creating and editing a Circuit Schematic

Create the circuit diagram using an OPA121E operational amplifier
from TI as shown in the following figure. Note that you can skip
creating this circuit; simply load this pre-drawn circuit from the Ex-
amples folder as “OPA121E Test Circuit.TSC” and go to the section
below to analyze it. You can also create the circuit yourself—see the
next section.

 If you just opened TINA and wish to create your own circuit, you can
start adding components right away. The circuit file name in the top
line is set to Noname by default, indicating that a new circuit file
Noname.TSC is being edited. If you already have a circuit loaded in the
editor you can start a new one with the File|New command. You can
switch between multiple circuits by clicking the Tabs at the bottom of
the screen.

Now start adding components. Left click on the voltage generator icon
then release the mouse button. The cursor will change into the genera-
tor symbol. Position it using the mouse (or by pressing the [+]/[Ctrl-
R] or [-]/[Ctrl-L] key for rotation] or the [*] key for mirroring) some-
where in the middle of the screen, then press the left mouse button to
drop the component into the schematic. We still need to set the prop-
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erties of this generator. Double-click on the generator and the follow-
ing dialog box will appear:

Leave the DC level, Signal, and the IO state parameters unchanged.
Note that by accepting Input for the IO state parameter you have
selected the output of this generator to be the input for this analysis (a
Bode diagram in this example). Click on the Signal menu line. The
dialog box will change as shown below:

Press the  button.  A new dialog box with the graphic icons of
available voltage generator signals will appear. When you select one of
them (in our case, click on the Square Wave button), the associated
curve comes up with some default parameters. In the case of  the
Square Wave signal, these are:
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Change the Amplitude to 500m (this represents 500mV peak), the
frequency to 100k (100kHz), and the Rise/Fall time to 1p (1ps).  Click
on OK and return to the previous dialog box and click on OK again.
The program will automatically place the label (VG1) near the compo-
nent and you will be able to position and place the component and the
label together. If  the default label position is not satisfactory, you’ll be
able to drag the label to the desired position later on.

Now click on the Spice Macros tab and press the leftmost Operational
Amplifiers button. The following dialog box will appear:

Click on the 3rd line (OPA121E) and press the OK button. (Alterna-
tively you can double-click on that line). The schematic symbol of this
opamp will appear and be attached to the cursor. By moving the mouse,
position the opamp as shown on the schematic at the beginning of
the section and then press the left mouse button to place the op amp
into your schematic.

Note that other types of ICs are available under the buttons next to
the Operational Amplifiers: Difference Amplifiers, Fully-Differential
Amplifiers, Comparators, Voltage Regulators, Buffers, Current Shunt
Monitors, and Other Components). You can bring all of  these various
components into the dialog box for any of the buttons if you set the
Show All Components checkbox. In addition to selecting an IC on the
list you can also find it by clicking on any item on the list and the typing

in the name of the IC. Another way of finding an IC is the  Find

Component tool at the top-right corner of the screen.

Now click on the Basic tab on the Component bar and click the Resis-
tor icon. The resistor symbol will be attached to the cursor. Move the
resistor to the position of the R1 resistor on the sample schematic
diagram at the beginning of this section and press the left mouse
button to place this resistor into the schematic. Double-click on the
resistor and the following dialog box will appear.
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Change the value in the Resistance field to 10k, and press OK.

Note that you can set a component value before placement while you
are moving it. To do that press the right button of  the mouse and
select Properties on the popup menu. The above dialog will appear
and you can set the properties of that component. After pressing OK
you can return to the component placement.

Now let’s place R2 at the top of  the circuit. Click on the resistor symbol
on the component toolbar, move and place the resistor. When you
drop the resistor you will see that its value is already 10k since the
program remembers the previous value.

Now let’s place R3 which needs to be turned by 90 degrees. Click on the
resistor symbol on the toolbar and turn the component by 90º by

clicking the  or  buttons or pushing the Ctrl L or Ctrl R keys.

(+ and – on the numeric keyboard have the same effect).  Place the
component on the right side of the screen and set its value to 1k with
the technique described above.

Continue circuit entry with the Capacitor, Battery, and Ground compo-
nents as indicated in the figure above. Set the parameters to C = 1 p,
V1=15, and V2=15. Place a Voltage Pin Out (chosen from the Meters
component group) at the right side of the new schematic. Pay atten-
tion to battery polarities and rotate the symbols if  necessary.

Note that even though all the computed voltages, currents and signals
are available after running an analysis (see below in this chapter and also
in the Post-processing analysis results section), you still need to define
at least one output. We have placed the parts into the schematic but
they are still unconnected. To connect devices, move the cursor over an
appropriate pin node until a small drawing pen icon appears. When
this pen appears, click the left button of the mouse, draw the wire, and
left click again at its endpoint.
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Finally, add a title to the schematic. Click the  icon on the toolbar and
the text editor will appear.

Type in: “Sample Circuit Using the OPA121E”. Click on the  icon
and set the font size 12. The editor also lets you choose another font
style, color, etc.

Now click on the  icon, and then position and drop the text into the
schematic.

Let’s check the circuit we have just built and run ERC from the Analysis
menu. If everything is OK the following dialog will appear:

If there is problem with the circuit, a list of warning or error messages
will appear in the dialog box. If you click on an error message, the
related part or wire will be highlighted in the circuit diagram.

Before going on to the next step, save your circuit using the File|Save
As command. Name the circuit “OPA121.TSC” (the .TSC extension is
added automatically). If you wish, you can still edit the circuit in many
ways:

• Add new components.

• Delete, copy, or move selected objects using the Edit|Cut,
Copy, Paste, and Delete commands.

• Move, rotate, or mirror groups of components. Select the com-
ponents one by one, holding down the shift key as you click on them.
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You may also use a window selection to identify the group by dragging
a box around the desired components. When you’ve selected the last
component, release the left mouse button,then move the cursor over
one of the selected components. Next press and hold down the left
mouse button, and drag the selected parts with the mouse. While
dragging, you can use the [+]/[Ctrl-L]/[Ctrl-R], [-] and [*] keys to
rotate and mirror components.

• Move any component label separately by clicking on it with the
mouse button and dragging it to the desired location before dropping
it by releasing the mouse button.

• Modify component parameter value(s) and labels of the         com-
ponent by double-clicking on it.

Of course, if you want to keep these changes you must save the circuit
again.

4.6 Analyses

TINA has a variety of analysis modes and options:

The analysis method is analog when a circuit contains only analog
components; then the components are modeled with their analog
models.

The analysis method is mixed when a circuit contains both analog and
digital components. TINA will analyze the analog parts in analog, the
digital parts in digital, and will automatically create the interfaces among
the components. This ensures synchronization and fast convergence.

The analysis method is digital when a circuit contains only digital
components; then the components are modeled with their fast digital
models.

Analysis Options

This dialog, with which you can set analysis parameters, is on the
Analysis menu. Examine the screenshot that follows to see the
parameters that you can adjust.

In this manual we will present only the most important options,
those which you might want to change. The complete explanation of
all the options is included in the on-line help, which you can display
pressing the Help button on the dialog.
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Note: If you change any settings in this dialog and close the dialog by
pressing the OK button, the program will remember the changed
settings.

Performance: TINA v9 and later support multi-core processors and
run analysis in parallel threads. This results in a significant speed
increase. By default the number of threads is equal to the number of
cores in your CPU. However you can control this with the Number of
threads parameter.

Number of threads: This parameter is set to Max by default and
results in one thread per core. You can, however, set it to any number
between 1 and Max, or to Dynamic. If you have a quad (4) core
machine, it would be good to set this parameter to 3, to leave some
computing capacity for other programs and processes. You can also
use the Dynamic parameter which controls the number of threads
automatically, depending on other processes running on your
computer.

Matrix compilation: By default this parameter is enabled and results
in compilation of an extremely fast code for some matrix operations.
The only reasons to disable this parameter are to perform speed
comparisons or to debug software. For maximum performance, it
should normally be enabled.

Enable run-time statistics: If this option is set, Tina displays the simu-
lation time of the transient analysis in the status bar and creates a file
which contains detailed information on the last transient run. You can
load this file by selecting the View.Transient statistics menu item.

Enable instant diagram drawing: If this option is selected TINA
will draw the diagram during transient analysis, refreshing the diagram
every 1-2 seconds. This is very useful for  observing the progress of
long calculations.

Save all analysis results: Check this box if you want to save the
result of all nodal voltages, resistor, capacitor and inductor
voltages and currents, to make the later post processing more
convenient. However this option may slow down the analysis by
30-50%.

Disable warning for large site analysis results If  you run a
transient analysis, a warning will appear if the number of points is
greater than 1,000,000 (1M).  Select this checkbox if you want to
disable this warning.
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4.6.1 Analysing the circuit

TINA has a variety of analysis modes and options, making it a very
versatile simulation tool.

The analysis method is analog when a circuit contains only analog
components; in this case the components are modeled with their ana-
log models.

The analysis method is mixed when a circuit contains both analog and
digital components; in this case the components are modeled with
their analog models.

The analysis method is a digital mode when a circuit contains only
digital components; in this case the components are modeled with
their fast digital models. (TINA-TI does not include this digital mode.)

Now let’s first check the operating point of  our circuit. Select DC Analy-
sis from the Analysis menu and select Calculate Nodal Voltages.

At the Out pin, the voltage of  this point, 10.53uV, will appear— which
is practically zero, as expected. In addition a probe shape cursor will
appear allowing you to test the voltages of all nodes. In the figure
below, the probe was placed on the op amp’s negative supply pin.

Let’s do another DC analysis by calculating the DC transfer
characteristic of this circuit.
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Select the DC Analysis|DC Transfer Characteristic… from the Analysis
menu. The following dialog box will appear:

Set the Start value to –7.5, the End value to 7.5, and then press OK.
After a short running time, a Diagram Window will appear as shown
below. This displays the circuit’s transfer curve—output voltage vs.
input voltage.

As in the Schematic Editor, you can add a title or any text to the
diagram by clicking the   icon on the Diagram Window toolbar. The
text Editor will appear:
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Type “Transfer Characteristic” and click the  icon. Now you can
position and drop the text into the diagram.

If you have already placed text into a Diagram, you can always bring it
back to the Text editor and edit it further by double-clicking on it. You
can change the font size with the  icon and there are also plenty of
graphic features under the  icon, described later in this section.

Now try executing an AC and Transient Analyses on your circuit.

First select AC Analysis|AC Transfer Characteristic... from the main
menu. The following dialog box appears:

The circuit’s Amplitude & Phase will be calculated by default. In addi-
tion, set the Amplitude checkbox on. Modify the Start frequency to 10k
and 100M respectively and press OK. A progress bar will appear while
the program is calculating. After the calculations are finished, the Bode
amplitude characteristic will appear in the Diagram Window. You can
easily switch to the Amplitude & Phase diagram by using the Tabs at
the bottom on the Diagram Window.
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You can read exact input/output values by enabling one or more of
the cursors, pressing the  and/or  and clicking on the curve where
you want to run the cursor(s). If you run two cursors you can see the
difference of the frequencies and values measured by the two cursors as
shown in the figure below.

Using the graphic facilities of TINA, you can add more useful infor-
mation to your diagram if  desired. As an example, let’s add markers, a
special annotation, and the circuit schematic itself  to the diagram. To
add markers to a curve move the cursor over the curve, find a position
when the cursor changes into a + shape and click on the curve at this
position. When the curve becomes selected, it turns red. Now you can
either double-click on it or press the right button of the mouse and
select Properties on the popup menu. A dialog box will appear and
you can set the curve’s parameters: Color, Line width, Marker. To select
Marker Type: Square and click on OK. To add some text, click on the 
text icon. The Text editor will appear. Enter “Amplifier” and by clicking
on the  button change the font size to 20. After returning to the text
editor press the  button and place the text at the top of the Diagram
Window.

When the Text editor appears, type in “OPA121E”. Note that using
the  font icon of the editor you can select any font, style, size and
color. Click on OK and place the text in the neighborhood of the

curve. Now click on the  pointer icon, then on the text, and finally

on the curve. Note that the cursor turns into a + when you are at the
right position.
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You have just entered a line and arrow that will always point from the
text to the curve, even if  you drag the text into another position or
make other changes.

Now place the schematic itself on your diagram. Click the schematic
editor Window and select Edit|Select All. Copy this selection into the
clipboard by selecting Edit|Copy or clicking on the Copy icon or using
the Ctrl C hotkey. Click on the Diagram Window and use Edit (Paste,
click on the Paste icon, or use the Ctrl V hotkey). The frame of the
circuit diagram will appear. Position and drop it at the left corner of
your diagram. Now you can still modify this picture by dragging or
double-clicking on it and changing its size, frame or background.

In a similar way you can do just the opposite and place the Bode
diagram into the Schematic diagram. To do that, click on the top cap-
tion part (or any empty place) on the Diagram window and press the
Ctrl C keys or use the Edit | Copy command in the Diagram window
menu to copy the diagram to the clipboard. Now select the Schematic
diagram window by clicking at an empty place or the top caption of the
window, and press the Ctrl V keys or the Edit | Paste command of  the
Schematic diagram window. Now you can move and place the dia-
gram on the schematic and then resize it by its corner handles or nu-
merically by double-clicking on the picture.
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Now perform a Transient Analysis. First, make sure your cursor is the
selection arrow, then double-click on the voltage generator and change
the waveform to the default unit step. After selecting Analysis|Transient
Analysis, the following dialog box appears:
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Change the End Display parameter to 20 u then press OK. In a sepa-
rate window the transient response waveforms will appear.  Exact
input/output data points can be read by enabling the  and/or 
graphic cursors.

You may want to see these two different curves in separate coordinate
systems. To do that, select the View Separate curves command in the
Diagram window. As a result, each curve will be displayed in a separate
diagram as shown in the next figure.
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4.6.2 Testing Your Circuit with Virtual
and Real Time Instruments

TINA lets you test and tune your circuit not only with the generators
and analysis windows that you have used so far, but also with virtual
and real-time measurements. Using the T&M menu you can place
realistic resizable virtual instruments on screen which will automatically
replace the generator and analysis windows. You can control the set-
tings of these instruments and immediately see the results, just as you
would in a real lab. TINA normally simulates measurements with its
analysis engine, but if  you have TINA’s TINALAb II optional Multi-
function PC Instrument, you can simply switch to the Real Measure-
ment mode. Now you can work with the same on-screen instruments
and settings and you will be making real measurements on a real circuit.

Note that even though circuit simulation driven virtual instruments
are very convenient to use, this is true for relatively small circuits only.
When the circuits are large and simulation of a change in the circuit
takes a long time, it is easier to use the classic analysis methods shown
in 4.6 section of this manual.

To begin working with virtual measurements, load the circuit, select
the T&M menu and place a Function Generator and a Multimeter on
your screen.

Click on the Multimeter’s  button. The Multimeter will show
only about 10u volts. Now click on the Offset button of Function
Generator and move focus to the first 0 after the + sign by clicking on
the  button or by using the Left and Right cursor arrows.
Now you can change the first digit of the offset voltage by clicking on

Up and Down cursor arrows or the  arrows on the Function

Generator and see the result on the Multimeter instantly.
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For example if you set 1V Offset on the Function Generator, the
Multimeter will show 2V. If  you raise the Offset voltage over 6V you
will see that the output voltage will go into saturation at around 12.7V
as we have already seen at the DC Transfer Characteristics.

You can also set the Parameters of  the Function Generator by pressing
the  button on the Function Generator, typing in the re-
quired number, and pressing Enter.

You can also see the effect of  changing component parameters through
their Property windows.

To demonstrate make sure that the  of  the Multimeter is On
and then double-click on the Voltage Generator symbol on the
schematic diagram.

The property window of the generator will appear.

increment
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As the focus is already on the DC Level parameter, which is the same as
the Offset on the Function Generator you can change it immediately

with the  buttons on the right side of the dialog box. The increment

is shown at the bottom field on the right side. By default the increment
is 100mV but, if desired, you can change the step size of the buttons
by entering it into the edit box.

Click on the  buttons and see effect instantly on the Multimeter.

Set back the DC level to 0 and click on the OK button of  the Voltage
Generator dialog box.

Press Run in the Oscilloscope panel and a square wave will appear on
the oscilloscope screen.

The wave is moving on the screen because by default the Oscilloscope
is Auto (free running) mode. To synchronize the waveform select
Normal mode with the list box below the Trigger field. The waveform
will stop moving on the Oscilloscope. You can trigger the waveform

with either a rising or falling edge by clicking on the  or the 

buttons.
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Now click on  button on the Function Generator. The waveform

on the oscilloscope will change into a sine wave as shown in the figure
below.

Now let change the amplitude of the sine wave provided by the

Function Generator. Click on the  button on the generator,
Move the focus with the  and  buttons to the first

digit of  the default 500mV, then change the amplitude with the 

buttons.

You can observe how the signal is distorted into a triangular waveform
by slew rate limiting at around 2V of input voltage as shown below:
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Now let’s invoke the Signal Analyzer from the T&M menu to study
the AC Transfer Characteristic of  our circuit. The following window
will appear.

A useful feature of virtual instruments of TINA is that they take over
the settings of the Analysis menu. Therefore, in our case, press the
Start button of the Signal Analyzer and the amplitude Bode diagram
will appear as shown in the figure below:

You can export the result into a conventional diagram pressing the

  button under the Data field at the bottom of the instrument.

You can make several other measurements (Phase, Two-panel
Amplitude & Phase etc. by selecting the required mode from the list
box under Display on the top of the instrument.
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You can use the other controls on this instrument to set the Frequency
Domain (Start and Stop under Frequency), vertical (Gain) axis
settings (High and Low under Display) and more, which you can
find in the help by clicking on the Oscilloscope and then pressing F1.

4.6.3 Analysis of SMPS circuits

SMPS or Switching-Mode Power Supply circuits are  an important part
of modern electronics. The heavy transient analysis needed to simulate
such a circuit may take a lot of time and computer storage. In order to
support the analysis of such circuits TINA provides powerful tools
and analysis modes. In this Chapter we will demonstrate these through
examples.

Using the Steady State Solver

The most time consuming part of an analysis of an SMPS circuit is to
reach its steady state, when the DC level of the output voltage does not
change  and the output waveform has only a small periodic ripple.

To find this state automatically, TINA has a Steady State Solver under
the Analysis menu.

To demonstrate this tool, let’s load the Startup Transient TPS61000.TSC
Boost Converter circuit file from the  EXAMPLES\SMPS\QS Manual
Circuits folder.

In this Boost Converter circuit the VG1 input line voltage is 1,2V. This
is converted by the SMPS circuit to 3,3V.
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Select the Steady State Solver from the Analysis menu. The following
dialog will appear:

The new parameters compared to the Transient Analysis dialog box
areas follows -

Max  searching  time: The solver will try to find the steady state solution
for max 20ms. After this, the analysis will discontinued whether or not
a solution was found..

Final checking time: After the steady state search is done, there is a final
check for the length specified here. You should have a stationary
waveform for this time interval.

Final accuracy: the maximum DC level change allowed. When the change
is below this, the analysis will end. Note that the 100m in the example
above means 0.1%

Method: You can select the method used for finding the steady state:

Transient: The steady state is searched by using transient analysis.
Finite-Difference Jacobian, Broyden update Jacobian: The steady state is
searched by the methods described in the paper, Automated steady-state
analysis  of  switching  power  converters  by  Dragan  Maksimovic.

Note that these last two methods may get to the steady state faster, but
they do not go through the normal transient states, so the resulting
waveform between the initial and final state does not reflect the real
process (but rather the mathematical path of the methods to get there).
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The new parameters compared to the Transient Analysis dialog box
areas follows -

Max  searching  time: The solver will try to find the steady state solution
for max 20ms. After this, the analysis will discontinued whether or not
a solution was found..

Final checking time: After the steady state search is done, there is a final
check for the length specified here. You should have a stationary
waveform for this time interval.

Final accuracy: the maximum DC level change allowed. When the change
is below this, the analysis will end. Note that the 100m in the example
above means 0.1%

Method: You can select the method used for finding the steady state:

Transient: The steady state is searched by using transient analysis.
Finite-Difference Jacobian, Broyden update Jacobian: The steady state is
searched by the methods described in the paper, Automated steady-state
analysis  of  switching  power  converters  by  Dragan  Maksimovic.

Note that these last two methods may get to the steady state faster, but
they do not go through the normal transient states, so the resulting
waveform between the initial and final state does not reflect the real
process (but rather the mathematical path of the methods to get there).

Now lets run the Solver. After a few minutes of running
(approximately 2 minutes on a 2GHz  Pentium computer) we’ll get
the following resulting waveform:
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These waveforms show the detailed transient from switching on until
reaching the steady output voltage. If you zoom out on the waveform,
you can see that the period of the switching is around 500kHz and the
time needed to arrive at the steady state is 4 milliseconds. Therefore, we
need to calculate at least hundreds or sometimes thousands of periods
if we want to see the whole transient waveform. This is why finding
the steady state is such a time consuming process. The reason for this
problem is the long start-up time of SMPS circuit compared with their
switching frequency. The start-up time is basically determined by the
filter capacitors on the output. The larger these capacitors are, the longer
the start-up time.

Sensor

The purpose of this component is to set the target voltage(s) to be
watched during the steady state search. You can add more than one
sensor to a circuit. By adding sensors, you can significantly accelerate the
steady state search. You can make the search even faster if  you can give
the final voltage at a certain node.

Using the “Max. no. of  saved TR. points” parameter in the Analysis/
Analysis parameters dialog, you can limit the maximum number of
points  placed  in  the  Diagram.  This  is  useful  for  large  analyses  to
accelerate diagram drawing. By increasing this parameter, you can refine
the diagrams but the drawing time will be greater.

NOTE:

In some cases you can accelerate the Steady State Search using the Finite-
Difference Jacobian and Broyden update Jacobian methods, however they do
not always converge and the intermediate waveforms provided by these
methods do not reflect the real waveforms of the transient process.
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The only electric parameter of the Sensor component is -

End Value: Voltage|Not Used

Trigger

Use this to determine the starting and ending times of the switching
period.

You can find this component on the Meters toolbar of   TINA. You
should connect it to the oscillator frequency control pin of the SMPS/
PWM  controller  IC,  but  any  node where  the  oscillator waveform of
the IC is present will  do.

If   you  double-click  on  the  Trigger  component  you  can  set  its
parameters.

Trigger voltage level: the threshold voltage for the trigger event

Hysteresis width: hysteresis value for the trigger event. This value
defines a region within which the trigger voltage is allowed to

oscillate without generating a trigger event.

Trigger State: Rise/Fall The direction of  the voltage change required
for a trigger event

Trigger  Count:  you  can  take  several  periods  for  the  waveform
analysis.

NOTE:

If the SMPS IC in the circuit includes the oscillator, like 61000 in our example,
this component is not needed.
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This is useful in case of very slowly changing output signals. The only
electric parameter of the Sensor component is -

End Value: Voltage|Not Used

Accelerating SMPS simulation using initial values

As we mentioned in the previous section, the long analysis time needed
for  reaching  the  steady  state  of  SMPS  circuits  is  mostly  used  for
charging the output filter and some capacitors. If we start the analysis
using initial values for larger capacitors and inductors, the analysis time
can be  significantly  reduced.  In  TINA, the  Steady  State  Solver  will
automatically place initial values into the model of larger capacitors and
inductors  and  so  the  following  Transient  Analysis  can  be  run
significantly faster (assuming that we do not make changes which will
need significantly different initial values).  For example, if you want to
study the effect of changing the output filter capacitor, it will not
significantly change the output voltage DC level. Therefore,  starting
the new analysis with an initial value calculated by the steady state solver
for another output capacitor, will result in a much faster analysis. You
can accelerate the analysis of  input and load changes in the same way.

To demonstrate this feature, let’s run a transient analysis for our
example. Selecting the Transient command from the Analysis menu,
the following dialog box appears.

NOTE:

Using the “Max. no. of saved TR points” parameter in the Analysis/Analysis
parameters dialog you can limit the maximum number of point placed in the
Diagram. This is useful for large analyses to accelerate diagram drawing. By
increasing this parameter you can refine the diagrams but the drawing time will
be slower.
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Note that Use initial conditions is set in the dialog. Press OK to start
Transient analysis. You should see that analysis runs very fast
compared to the previous steady state analysis. The output waveform
is shown in the picture below.

Why did the analysis run faster? Transient analysis was already preceded
by the Steady State Analysis and the main capacitor’s initial values (called
Initial DC voltage in the Capacitor property box) was  already  set  to
the  final  DC  voltage.  For  example , if  you double-click on the C3
capacitor, you will see that the Initial DC voltage is already set to 3.31 V.
Similarly, all the larger capacitor’s initial values are set.

Once  you  have  checked  the  initial  transient, the  steady  state
waveform, and SMPS circuit, the next thing you normally want to
know is how it behaves when the input voltage or the load changes.
This is realized by the Input step and the Load step analyses.
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Input step analysis

One of the standard analyses for SMPS circuits is the calculation of the
response to an input change to test the capability of the SMPS design
to regulate  the  output  with  step  changes  in  the input  line.  This  can
be accomplished by adding a pulse to the input voltage and checking
the output and other voltages. Since the input change is relative to the
steady state, we can start it from the steady state initial values calculated
by TINA’s steady state solver.

Load the Startup Transient TPS61000.TSC Boost Converter circuit file
from the  EXAMPLES\SMPS\QS Manual Circuits folder. The
schematic design is the same as above.

To  see  the  input  step  waveform,  double-click  on the  VG1
voltagegenerator on the left. The following dialog box will appear:

According this, the input voltage is 1.2V. This is converted by the
SMPS circuit to 3.3V.

Now click on the Signal line of the above dialog and then the  
button. The following signal in the Signal Editor will appear:
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According to the waveforms, the input voltage will decrease from 1.2V
to 0.8V for a T2=1ms time; and the starting edge (T1) and the ending
edge (T3) of the pulse are 10us.
To see the response of the circuit,  let’s invoke and run the Transient
analysis from the Analysis menu.

Load step analysis

Another standard analysis is to determine the SMPS response to a fast
load change. Using simulation, the response to load changes is
obtained by adding a current pulse to the load and analyzing the
output and other voltages. Since the load change is relative to the
steady state we can start it from the steady state initial values calculated
by TINA’s steady state solver.

Now load the example Load Step Transient TPS61000.TSC. The
schematic design  is  the  same  as  above , except  for  the  ILoad
Current generator on the output.
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If you double-click on the ILoad generator and check its waveform,
you will see that the DC part is 5mA while the pulse is 45mA in
amplitude and 1ms in width.

Accordingly, the 5mA load current will rise to 50mA and then decrease
to 5mA again.

Note that the output current is shown through the ILoad generator
where the IO state parameter is set to Input.

Let’s run Transient from the Analysis menu and see the result.

AC analysis

For AC analysis and stability analyses you can use the so called Average
models provided in TINA. The average models represent a method,
based on averaging the effects during the switching process. The
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resulting equations are linear therefore the method is extremely fast in
order to draw Bode and Nyquist plots needed for stability analysis.
Note that for using the AC analysis function of TINA you need an
average model, the transient models are not applicable and will give
improper results.

To demonstrate this tool, let’s load the Average model TPS61000.TSC
circuit file from the  EXAMPLES\SMPS\QS Manual Circuits folder.

Note  the  VAC generator which is providing signal for the  AC
analysis., and  the  AC In Voltage  pin which is the Input of  the AC
analysis (its IO state parameter is set to Input).

Let’s run AC Analysis/AC Transfer Characteristic… from the Analysis
menu and see the result.
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CHAPTER 5

CREATING

SUBCIRCUITS FROM

SPICE MACROS AND

MODELS

In TINA-TI, you can simplify a schematic by turning portions of it
into a subcircuit. In addition, you can create new TINA-TI
components from any Spice subcircuit, whether created by yourself,
downloaded from the Internet, or obtained from a manufacturer’s
CD. In this chapter, we show through text and examples how easy it is
to do this in TINA-TI.

5.1 Making a Macro from a schematic

Using TINA’s macro facility, you can simplify schematics and hide
clutter by turning portions of  the schematic into a subcircuit. TINA
automatically represents these subcircuits as a rectangular block on
your schematic, but you can create any shape you like with TINA’s
Schematic Symbol Editor.

You can convert any schematic diagram into a subcircuit - called a
Macro in TINA - simply by adding the terminals and saving the new
circuit in the special (*.tsm) format.



74

Schematic Macros

TINA Quick Start

S
C

H
E

M
A

T
IC

 M
A

C
R

O
S

Now let’s see how to create a macro in TINA through an example.
Load the Half Adder example (Half_add.tsc) from the Examples folder
of  TINA and convert it into a macro.

Delete the old terminals and replace them with subcircuit terminals,
called Macro Pins in TINA. You can find and select the Macro Pins
under the Special component toolbar.
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When you place Macro Pins, labels (such as Pin1, Pin2 etc.) are
pre-filled in. Double click the Macro Pin and type in the new name in
the label field. You can also drag the component with the mouse, or
rotate it with the [+] and [-] keys or the  buttons.

Next, create and save the new macro. Select the New Macro Wizard from
the Tools menu. Set the Name to Half  Adder (this will be displayed in
the macro box that opens automatically), and set the Label to HA. This
label will be displayed as the component label above the component.
Note that you can leave this field blank if you don’t want a component
label.

When done, press OK. A Save dialog box will appear. Set Half Adder
as the File name and press Save. Note that there is already a macro
with a similar name (Half_add.tsm). This has the same content as the
one we just created, and is included for reference. You can also use it
in the next section.
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Our new macro will appear as a cursor. Move it to the center of the
screen and click the left mouse button. The full symbol of  the new
macro will appear. Note that a rectangular schematic symbol has been
automatically created, the macro name we specified is inside the
rectangle, and the label name is above it.

Now you can add more components to the circuit, connecting them to
the newly created macro, and start analysis as with any other circuit.

To check the content of  the macro, double click on the symbol and
TINA will display the model.

To return to the main circuit, click the Leave Macro button on the
screen at the upper left, use the File/Leave Macro command, or the
right click popup menu.

TINA allows a hierarchical macro structure; that is, macros can
contain other macros inside, and so on. Let us use our half adder
macro to create a full adder macro containing two half adder macros.

Now let’s see how to insert a macro into a schematic and use it.

Clear the circuit with File|New or by restarting TINA. Select
Insert|Macro, then our newly created Half  adder.tsm, and click Open.
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To do this, insert the newly created Half  Adder twice into a new circuit
and then add the additional components and wires as shown in the
following picture.
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Now create and save the new macro with the New Macro Wizard from
the Tools menu. At this point let us note that although the automatic
symbol creation is very convenient, you can also create your own
schematic symbols with TINA’s Schematic Symbol Editor and assign
macros to them. Let us use this feature with an existing symbol. The
creation of  such a symbol will be described later in detail.

Set the Name to Full Adder and set the Label to FA (this will be
displayed as the component label above the shape). Uncheck the Auto
generated checkbox and press the  button next to it. The list of
available symbols will appear as shown below.

Note that in order to see the predefined symbols, the Macro Pin Label
names must exactly match the names in the symbol. In our example,
they must be (A, B, Ci, Co, S). If  you do not see the symbol shown in
the figure above, check the terminal names or try to recreate the symbol
as shown later at “Making your own schematic symbols”.

Click the schematic symbol with the large summation sign and press
OK. The name of  the schematic symbol will appear in the shape
field of  the New Macro Wizard dialog box. Finally, click OK and
save the macro under the name of  Full adder.tsm.
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To see our newly created full adder macro, select Macro from the Insert
menu and then select Full adder.tsm and click Open.

Double click on the symbol and the schematic inside the circuit will
appear, showing two of  our previous half  adder macros. You can then
double click on either of the macros to see the schematic inside. Return
to the Full Adder and the main circuit by clicking the Leave Macro
button.
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5.2 Making a Macro from a Spice subcircuit

5.2.1 Creating Spice Macros in TINA

5.2.1.1 Creating macros from downloaded files

In TINA, you can create your own components from any Spice
subcircuit that you have made or downloaded from the Internet. Note
that there are already many  Spice component models in the large and
extensible manufacturers’ model library provided with TINA. The
extension of those libraries is described later.

Let’s create a UA741 operational amplifier using a Spice subcircuit.

To do this, select the New Macro Wizard from the Tool menu.  The
following dialog box will appear:

Change the settings from Current Circuit to From file and press the

button. An Open dialog box will appear.
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Now  lets navigate to the EXAMPLES\SPICE folder of TINA using
the small arrow next to the Open button.

Select the UA741.CIR file and press the Open button.   The New macro
Wizard dialog will appar again with the path and name of the selected
file. Now  press the Next > button. The following dialog will appear:
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If you want something different, you can view and select a symbol by
pressing the long vertical button on the right.

Press the Next button. The following dialog will appear:
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The dialog shows how the pin names on the graphic symbol are
associated with the Spice node names in the macro. It also shows the
text of the macro so you can check that the connections are properly
made. If not, you can drag the macro node names to any terminal.
However if all the pins are connected with a node number, then most
likely the association is correct.

You’ve checked the connections; now press the Next button again. A
Save dialog will appear and you can save the macro into the User mac-
ros area under Documents\Designsoft\TINA_Industrial_install
date_id_number\Macrolib or to the TINA macros area, under
Program Files. For easier file selection, use the small arrow next to the
Save button. Note that under Vista and Windows 7, you cannot
normally write into the TINA program area. After saving your macro,
you will see a dialog with which you can test the macro or close the
wizard altogether.

Now we will see how to insert the new (or any other) subcircuit into a
schematic and check its contents. Select the Macro command of the
Insert menu.

NOTE:

Click the UA741.TSM file and then press Open. Now the new macro
will be attached to the cursor. Position it on the screen and drop it by
clicking the left mouse button. Double click the symbol to see its
content. The netlist editor will appear, showing the macro in detail.
Note that you can modify this netlist, and the modified netlist will be
saved with your circuit. However this will have no effect on the original
macro; it remains unchanged.

You may need to select the User Macro or TINA Macro area using the
selection arrow next to the Open button, or navigate there using the selection
list on the top of the Open dialog.
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5.2.1.2 Creating macros on-the-fly by browsing the web

A more convenient way to add new models to TINA is to browse
manufacturer websites and add the Spice models of interest from the
web site. Of course it also possible first to download the models and
use the technique described in the previous section. Note that even if
you prefer the latter you may find useful hints in the following section.

Now let’s select the From the web option in the wizard and press the
 button.

TINA’s built-in internet browser will appear. Use this browser to find
and select the THS4121 differential opamp from Texas Instruments.
Enter www.ti.com and find the Spice macro on the TI web site using
TI’s Search option , or just  enter following URL directly (use copy and
paste if you like)

http://focus.ti.com/docs/prod/folders/print/ths4121.html  (Note
that the direct link above may change).

The THS4121 product page will appear. Scroll down the screen and
find the link to the Spice model of this product shown below in red.

Click on the link. The following message appears in TINA:
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The file is compressed (or “zipped”), but TINA can open and download
the files you need directly. Click the Yes button, and observe the next
screen.

Click to select the THS4121.lib file

and press Open.  The New Macro Wizard will appear again, with a
(green) message (File downloaded press Next) confirming the success-
ful download
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Press the Next button.

If there is more than one macro in the file, TINA presents them in a
list.
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NOTE:

You can bring these device models into TINA macros with this tool by
selecting them one-by-one.
If there are a lot of models, you might want to use the Library
Manager tool which allows you to add all the models into the TINA
catalog in one step.  Learn about it in the next section.
Now press the Next button.  The wizard will show the schematic
symbol (shape) suggested:

You can choose other shapes, if  available, by pressing the long vertical
button to the right of the symbol.

Some manufacturers place several device models in the same file.

NOTE:

You may need to uncheck the “Show suggested shapes only” filter to see
more shapes.
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In this mode, you can also search by name, by the number of  pins,
and by function (op amps, comparators etc.) You must select the Shape
type option before searching by function.

In our example, TINA appears to have automatically selected an
appropriate shape, so you may now press the Next button. The
selected shape, pin connections, and Spice macro text will appear.

Take a moment to check the connections and if  necessary correct them
by dragging the connection labels.

If everything is correct, press the Next button again. The Save dialog
will appear and you can save the macro into the User or TINA folder.
Do so immediately, or do it later using the Insert menu.

Now let’s insert a model from another manufacturer. Our choice is the
LM111 comparator from National Semiconductors.

After invoking the internet browser in TINA find the Spice model
page at http://www.national.com  which is, at the time of  writing this
manual, http://www.national.com/analog/amplifiers/spice_models.

Scrolling down the page you will find the LM111 model under
LM111.MOD name as shown below.
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Click on the link and the text of the Spice model will appear in TINA.

Now click on the  Open icon at the top-right corner of the browser
window, and the Macro Wizard will appear again confirming the
successful load. Press Next. TINA will automatically present the
selected symbol.
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The remaining steps are the same as described in the previous section.

5.2.2 Adding Parameters to Spice Macros

TINA lets you add parameters to Spice subcircuits and set them from
TINA. The parameters in the subcircuit are defined by the standard
Spice syntax using the PARAMS keyword. For example look at the
subcircuit  in the circuit  given in the MAC_RLC.TSC file in the
EXAMPLES\SUBCIRC folder.

If you double-click on the RLC subcircuit and press the Enter Macro
Button, the content of the subcircuit will appear:

.SUBCKT RLC In Out PARAMS: R=100 L=1M C=1N C1 Out

0 {C}

L1 1 Out {L}

R1 In  1 {R}

.ENDS
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The parameters are R, L and C. You can set the parameters in the
property dialog of the subcircuit in TINA created as described in this
chapter. In our example

Edit the parameters either in the SubCkt-Parameters line or click the 
button and the Macro Parameter Editor dialog will appear.
Enter or edit the parameters you want to change and press the OK
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CHAPTER 6

MAKING YOUR OWN

SCHEMATIC SYMBOLS

Using TINA’s Schematic Symbol Editor, you can create new schematic
symbols so that you can add your own circuit components to TINA.

To create new symbols, you place lines, arcs, rectangles, and arbitrary
characters with any fonts, specifying line-width, color, and area color
fills. After drawing the symbol, you add and define connections to it.

To get acquainted with some features of  the editor, read in the list of
existing symbols. Use the Windows 95 Start menu to locate the TINA
PRO folder. Start the Schematic Symbol Editor by clicking its icon,
then Select File|Open and double click on the devices.ddb file. On the
right hand side of  the Editor Window, the list of  current schematic
symbols will appear.
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The first symbol on the list (an Ammeter) will appear in the editor
window. Try the Dir: control at the bottom of  the screen. Using this
control, you can provide different shapes for symbols at each rota-
tional orientation by designing each of  them individually. Now click
on the NAND symbol at the right side of the screen and press the 
button. The NAND gate symbol will appear in the editor window.
Try the Standard: control to see the US and European versions of
the part shape. You can design symbol versions for each standard, if
necessary. If  the symbols are identical in the two standards, you need
create only one version.

Now let’s create a symbol for the full-adder circuit that was used
above in our example of  creating a half  adder macro.

First clear the editor window by pressing the  button or by
selecting the actual symbol in the editor window and pressing
the Del button. Now draw a rectangle as the body of  the com-
ponent.  First press the  button then click on any point in the
drawing area, hold the mouse button, and move the mouse until
the rectangle is properly sized.

Fill the rectangle with a color by right-clicking on the palette at the
lower left corner of  the window. Note that a left-click will change
the foreground color (FG), in our case the border of  the rect-
angle.

Now add the terminals. Select the desired terminal type from the
Terminal-Toolbar in the upper left corner of  the window and move
the cursor into the rectangle you just drew. Position it using the mouse
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or pressing the [+] or [-] key for rotation and click to locate the
terminal. Be sure the small red x, indicating the pin end, is outside
the body. Continue this process until every terminal is positioned.

After you have positioned all the terminals, you can establish their
properties by double clicking on each of  them.

You should assign terminal names as shown in
the picture below.

Next, add a large summation sign. Click on the
 -Text-Editor button on the Toolbar, enter

an S in the window, and select a font. To get
the special Greek summation sign, select the
Symbol-Font.

Press the –Device Properties button,  set
the Name of  the symbol to Full Adder, and
press OK.

Finally, copy the new symbol into the symbol library with the 
button (it appears now at the end of  the list), and use the File|Save
command to save the now extended devices.ddb file in the TINA
main directory.





Advanced Topics

TINA Quick Start 97

A
D

V
A

N
C

E
D T

O
P

IC
S

CHAPTER 7

ADVANCED TOPICS*

7.1 Introduction

In the previous chapters, we have introduced TINA’s main features
and how they can be accessed. Our demonstration, however, is far
from complete, for TINA contains many other useful and advanced
features for designing, testing and teaching electronics and electronic
circuits. These include S-parameter models, network analysis, details
of  Fourier series and Fourier spectrum analysis, symbolic analysis,
post-processing of analysis results, creation of phasor diagrams,
Nyquist diagrams, the built-in interpreter, multiparameter
optimization, creation of multilayer PCBs and other topics.

The detailed description of these topics is not included in the printed
Quick Start manual; they are published only in electronic form. They
can be found on the TINA install CD and on the web at www.tina.com
in the Documentation section

www.tina.com/support.htm.

* Not all features described here are available in TINA-TI
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7.2 Table of Contents of Advanced Topics

• Parameter Stepping

• DC Transfer Characteristic and Parameter Sweeping

• Phasor Diagram

• Nyquist Diagram

• Noise Analysis

• Network Analysis and S-parameters

• Symbolic Analysis

• Post-processing Analysis Results

• Design Tool

• Optimization

• Design Tool vs. Optimization

• Fourier Series and Fourier Spectrum

• Interpreter manual

• TINA PCB Design manual

We are continuously adding new topics and examples to this chapter,
so please check back regularly to the Documentation section of  our
website www.tina.com for the latest version.


